
Basics
WinSight gives you debugging information about window classes, windows, and messages. Using 
WinSight, you can study how any application creates classes and windows and monitor how windows 
send and receive messages.

WinSight uses three views to study applications:

Window Tree view
Class List view
Message Trace view

WinSight is a passive observer: it intercepts and displays information about messages but does not 
prevent messages from getting to applications.

To watch windows sending and receiving messages, you can use WinSight to do the following:

Find the window(s) you want to watch
Trace the messages that get sent

What you need to know to begin using WinSight
Choose one of these topics for more information:

Getting Started

Messages WinSight Tracks 

WinSight Views



Tasks
Choose one of these topics for information about using WinSight:

Tracing Messages

Using the Find Window Mode

Using the Keyboard with WinSight

Using the Messages Menu to Trace Messages

Using the Mouse with WinSight

Using the Spy Menu to Display Window Details

Using the Start! and Stop! Menu

Using the Tree Menu to Display the Window Tree View

Using the View Menu to Display WinSight Views



Getting Started
See Also
To start WinSight, double-click the WinSight icon.

The first time you start WinSight, it displays the Window Tree view.

When you exit, WinSight saves your configuration. If you open all three views and exit WinSight, the 
next time you start it, all three views will be displayed.





Using the Mouse with WinSight
Here is a list of actions with mouse and menu equivalents.

Action With the mouse With menus

Select an item Click

Select multiple items Ctrl+click

Toggle highlighted item Shift+click

Show details of item Double-click Spy|Open Detail

Expand one level Click on <+> Tree|Expand One Level

Expand branch Right-click on <+> Tree|Expand Branch

Collapse branch Click on <-> Tree|CollapseBranch

You can also use the mouse to resize the WinSight window or the panes.



Using the keyboard with WinSight
Here is a list of actions with keyboard and menu equivalents.

Action With the keyboard With menus

Select an item Up or Down arrow

Select multiple items Ctrl+Shift Up or Down 

arrow

Move selection bar Ctrl+Up or Down arrow

Toggle highlighted item Spacebar

Expand one level + Tree|Expand One LevelTExpandOneLevel

Expand branch * Tree|Expand BranchTExpandBranch

Expand tree completely Ctrl+* Tree|Expand AllTExpandAll

Collapse branch - Tree|Collapse Branch

The right and left arrows scroll horizontally.

Use Tab or F6 to move the focus between panes. Use Shift+Tab or Shift+F6 to switch the focus in the 
opposite direction.





Using WinSight
See also
WinSight gives you debugging information about window classes, windows, and messages. You can 
study how any application creates classes and windows, and monitor how windows send and receive 
messages.

WinSight uses three views to study applications:

Window Tree view
Class List view
Message Trace view

WinSight is a passive observer: it intercepts and displays information about messages but does not 
prevent messages from getting to applications.

To watch Windows sending and receiving messages, you can use WinSight to

Find the window(s) you want to watch
Trace the messages that get sent.

Note: WinSight 16 (WINSIGHT.EXE) supports 16-bit Windows systems and WinSight 32 (WS32.EXE) 
supports 32-bit Windows systems.



Find Window Mode
See also
Find Window mode allows you to monitor how specific windows send and receive messages. To enter 
Find Window mode choose Spy|Find Window.

Note: All other applications are suspended while you are in Find Window mode.

Selecting Windows
In Find Window mode, you can select windows in one of two ways:

Move the mouse into the boundaries of a window object. A thick border appears around that 
window object, and the corresponding window name is highlighted in the Window Tree view. 

Use the cursor keys to select windows from the Window Tree view. When you hightlight a window 
name, WinSight puts a thick border around the corresponding window object.
To leave Find Window mode, click the mouse button, or press Escape. This removes the border from 
the screen but leaves the current window selected in the Window Tree view. 

If you press Enter or double-click the highlighted window in the Window Tree view, you will see the 
Detail window.

Note: In WinSight 32 (WS32.EXE), you must use the up and down arrow keys to highlight a window 
when you are in Find Window mode. Select a window in the Window Tree view, then use the 
arrow keys to move through the Window Tree. The windows you select in the Window Tree will be 
outlined as you move through the tree.



Tracing Messages
See also
When you monitor how windows or classes send and receive messages, you are tracing the patterns of 
these messages.

By default WinSight traces all messages and displays them in the Message Trace view.

You can trace messages in one of three ways:

Choose Messages|Selected Classes or Messages|Selected Windows, then shift-click to select 
the classes (in the Class List view) or windows (in the Window Tree view) you want to trace.

Choose Messages|All Windows to select all the messages sent to windows.
Choose Messages|Options, then select any or all of the ten groups of messages.

Choose Stop! or Messages|Trace Off to control when WinSight stops tracing messages. The Message 
Trace view remains visible. 

To resume tracing, choose one of the following menu commands:

Start!
Messages|Selected Classes
Messages|Selected Windows
Messages|All Windows





WinSight menu commands
Here is a list of the menus and menu commands in WinSight. The menus are listed in the order they 
appear.

Spy Menu

Open Detail

Find Window

Follow Focus (WS32.EXE only)

Switch To (WS32.EXE only)

Exit

View Menu

Class List

Window Tree

Message Trace

Split Horizontal

Split Vertical

Tree Menu

Expand One Level

Expand Branch

Expand All

Collapse Branch

Messages Menu

Trace Off

Selected Classes

Selected Windows

All Windows

Clear

Options...

Processes... (WS32.EXE only)

Stop! and Start!

Help Menu

Index

Finding Windows

Tracing Messages

Menu Commands

Keyboard

Mouse

Using Help

About WinSight





Spy Menu
Use the Spy menu to display more details for a window, locate the window for which you want to trace 
messages, or exit WinSight.

The Spy menu commands are:

Open Detail

Find Window

Follow Focus (WS32.EXE only)

Switch To (WS32.EXE only)

Exit



Spy | Open Detail
Choose Spy|Open Detail to display more detail about the selected class or window.

Use this command to open the Detail window. The information in the window depends on the current 
active view, indicated by the dotted rectangle. 



Spy | Find Window
Choose Spy|Find Window to locate the window for which you want to trace messages. Use this 
command to enter Find Window mode.

Note: In WinSight 32 (WS32.EXE), you must use the up and down arrow keys to highlight a window 
when you are in Find Window mode. Select a window in the Window Tree view, then use the 
arrow keys to move through the Window Tree. The windows you select in the Window Tree will be 
outlined as you move through the tree.



Spy | Follow Focus
You use the Follow Focus command to easily select the window you want to monitor in the Window Tree 
view. Follow Focus is available only in WinSight 32 (WS32.EXE).

To use Follow Focus:

1. Choose Follow Focus from the Spy menu.

2. Click on the window you want to monitor; WinSight highlights that window in the Window Tree view.

When you click on a window, that window gains focus. If the window you click on covers the WinSight 
display, click on the title bar of WinSight to view the Window Tree view.

Follow Focus stays active until you toggle it off via the Spy menu.



Spy | Switch To
The Switch To command gives focus to the window that you select in the Window Tree view. Switch To 
is available only in WinSight 32 (WS32.EXE).

To use Switch To:

1. Select (highlight) the window you want to give focus to in the Window Tree view of WinSight.

2. Choose Switch To from the Spy menu.



Spy | Exit

Choose Spy|Exit to exit WinSight.



View Menu
Choose the View menu to select a view and how WinSight displays it, either horizontally or vertically.

The View commands are:

Class List

Window Tree

Message Trace

Split Horizontal

Split Vertical



WinSight Views
See also
WinSight can display three views within its main window:

Class List
Window Tree
Message Trace

The Window Tree view is the initial default view, but you can use the View menu to open or close any of 
these views. 

When you exit WinSight, WinSight saves your current desktop configuration. 

WinSight automatically tiles the views within the main window, however, you can resize them. 



View | Class List

Choose the View|Class List command to display the Class List view.

If the Class List view is displayed, choosing this command hides the view.

Note: The term "class" refers to the class name with which the window class was registered with 
Windows via the RegisterClass API function. It does not refer to C++ classes.



Class List View
See also
The Class List view displays all the currently registered window classes. 

The format for the classes in the Class List view is:
Class (Module) Function Styles

You can see more information about a window class in the Detail window by doing one of the following:

Double-clicking the window class in the Class List view.
Selecting the window class and press Enter.
Selecting the window class and choose Spy|Open Detail. 



View | Window Tree

Choose View|Window Tree to display the Window Tree view.

If the Window Tree view is displayed, choosing this command hides the view.



Window Tree View
See also
The Window Tree view displays the hierarchy of windows on the desktop.

Use this display to do the following:

Determine what windows are actually present.
See the status of windows, including hidden windows.
See which windows are receiving messages.
Select the windows you want to trace messages for.

The format for the classes in the Window Tree view is:
Tree Handle {Class} Module Position "Title"

You can see more information about a window in the Detail window by doing one of the following:

Double-click the window item in the view.
Select the window item and press Enter.
Select the window item and choose Spy|Open Detail.



Detail Window
See also
The Detail window displays the class name, executable module, and other information about the 
selected window or class.



View | Message Trace

Choose the View|Message Trace command to display the Message Trace view.

If the Message Trace view is displayed, choosing this command hides the view.



Message Trace View
See also
The Message Trace view displays information about messages received by selected windows or 
windows classes.

SendMessage messages are shown twice, once when they are sent and again when they return. 

Dispatched messages are shown only once, since their return value is meaningless. The message 
display is indented to show how messages are nested within other messages.

The format for the messages in the Message Trace window is:
Handle "Title"-or-{Class} Message Status ...

Win32 Messages
Winsight checks if the task whose messages are being traced is a Win32 task. If so, it displays [Win32] 
immediately after the window handle on traced messages. These messages, however, are displayed in 
Win16 message format.

WS32 response time
WS32.EXE also displays the symbols + and * to denote the following:

* means that WS32.EXE was too slow to catch all the messages
+ means a time out occurred in the hook procedure

The HookTimeOut setting in the WinSight.INI file (located in your Windows directory) denotes the time 
out for the WinSight hook procedure in milliseconds. If you set HookTimeOut = 1000 (the default), 
WinSight will time out for 1 second between messages. If you decrease the value of this setting, 
WinSight will respond faster, at the risk of loosing messages. Increasing this setting will slow down 
WinSight, but will increase the chance that it will catch all messages.



View | Split Horizontal

Choose View|Split Horizontal to stack the views on top of one another.



View | Split Vertical

Choose View|Split Vertical to display the views side by side.



Class
The name of the window class. 

Some predefined Windows classes have numeric names and are shown with the number and a name. 



Module
The name of the executable module (.EXE or .DLL) that registered the class or created the window.



Function 
The address of the class window function.



Styles 
A list of the CS_ styles for the class. The names are the same as the CS_ definitions in WinTypes, 
except that the CS_ is removed and the name is in mixed case.



Tree
The lines and diamonds on the left of the view show the window tree structure. Each window is 
connected to its parent, siblings, and children. 



Handle
The window handle returned by CreateWindow.



Position
The window's position. 

If the window is hidden, the text "(hidden)" is displayed. 

If the window is visible, the window coodinates are given as (xBegin,yBegin)-(xEnd,yEnd). Top-level 
windows use their own screen coordinates. Child windows use coordinates within the parent window 
client area. 



Title
The window title or text, returned by GetWindowText or a WM_GETTEXT message. If the title is the null 
string, the quotation marks are omitted.

If the title is a null string in the Message Trace window, the class name is displayed in curly braces.



Message
The message name defined in WINDOWS.H. 

Known undocumented Windows messages are shown in lower case. 

Unknown message numbers (user-defined) are shown in one of the following formats: 

WM_USER+0xXXXX if they are greater than or equal to WM_USER 
WM_0xXXXX if they are less than WM_USER.

Registered message numbers (from RegisterWindowsMessage) are shown with their registered name in 
single quotation marks.



Status
One or more of the following items may be reported:

Dispatched The message was received via DispatchMessage

Sent [from XXXX] The message was received via SendMessage. If it was sent from another window, 
"from XXXX" gives that window's handle. If it was sent from the same window 
receiving it, this is shown with "from self." If it was sent from Windows itself, the 
"from" phrase is omitted. 

Returns The message was received via SendMessage and is now returning.



...
Additional information specific to each message.

If a "returning message", the return value, either in numeric form, or more specific information for 
messages such as WM_GETTEXT. 

If a "sent and dispatched message", the message parameters. WinSight interprets the parameters to 
give a readable display. If a message has associated data structures, those structures are included in 
the display.





Tree Menu
Choose the Tree menu to display, expand, or collapse window entries in the Window Tree view.

The diamonds on the left of the Class List and Window Tree windows invert color momentarily when the 
window receives a message. They also show if the window class has any children:

The window has no children. 
The window has children, but they are hidden. To expand and see the children, click on the 

diamond, or select the window and press 
. To expand to show all levels of child windows, select a window and right-click.

The window has children, and they are visible. To hide the children again, click the diamond, or 
select the parent window and press 
.
The Tree menu commands are:

Expand One Level

Expand Branch

Expand All

Collapse Branch



Tree | Expand One Level (+)
See also
Choose Tree|Expand One Level to expand an entry one level in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



Tree | Expand Branch (*)
See also
Choose Tree|Expand Branch to expand an entire branch in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



Tree | Expand All (Ctrl+*)
See also
Choose Tree|Expand All to expand all branches that are collapsed in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



Tree | Collapse Branch (-)
See also
Choose Tree|Collapse Branch to collapse an entire branch in the Window Tree view.

A minus sign in the diamond ( ) next to an entry indicates that the window's children are currently 
hidden. Tree|Expand All

Tree|Expand Branch
Tree|Expand One Level



Messages menu
See also
Choose the Messages menu to select the types of messages you want to trace for the selected 
window(s).

You can configure WinSight to trace messages by:

Window
Window class
Message type
A combination of these

The Messages menu commands are:

Trace Off

Selected Classes (16-bit WinSight only)

Selected Windows

All Windows

Clear

Options...

Processes,,,



Messages | Trace off

Choose Messages|Trace Off to turn off message tracing. The Message Trace view remains visible.

Tracing resumes when you choose one of the following menu commands:

Messages|Selected Classes
Messages|Selected Windows
Messages|All Windows

You can also use Stop! to turn off message tracing.



Messages | Selected classes

Choose Messages|Selected Classes to trace messages going to a particular class.

This command is available in only WINSIGHT.EXE (the 16-bit WinSight) after you have selected a class 
in the Class List view.

Changing the selection in the Class List view will immediately change which windows have messages 
traced.

Choose Messages|Selected Classes to open the Message Trace view when it is hidden.



Messages | Selected windows

Choose Messages|Selected Windows to trace messages going to a particular window.

This command is active only if you select a window in the Window Tree view.

Changing the selection in the Window Tree view will immediately change which windows have 
messages traced.

Choose Messages|Selected Windows to open the Message Trace view when it is hidden.



Messages | All windows

Choose Messages|All Windows to trace all messages, regardless of what is selected in the Window 
Tree view or the Class List view.

Choose Windows|All Windows to open the Message Trace view when it is hidden.



Messages | Clear

Choose Messages|Clear to clear all messages in the Message Trace view.



Messages | Options...

Choose Messages|Options... to open the Message Trace Options dialog box.

Use the Messages Trace Options dialog box to choose the types of messages you want to trace.

Tip: For best performance, choose Stop! before you choose the Options command.

Messages to Trace check boxes
Use the Messages to Trace check boxes and the Individual Messages List Box to specify which 
messages to trace.

Interpret and Hex Values check boxes
Use the Interpret Value, Hex Value, and Show Times checkboxes to determine the message display 
format.

Log File check box
Use the Log File check box to log traced messages.



Messages | Processes...

Choose the Processes command to display the Trace Process Messages dialog box. You can use this 
dialog box to select the processes whose messages you want to track:

Highlight the specific procsses you want to monitor, then choose OK.
Check All Processes if you want to monitor all running processes.
Check New Processes if you want to monitor new processes as you start them.

Tip: For best performance, choose Stop! before you choose the Processes command.

Note: The Processes command is available only in WinSight 32 (WS32.EXE).



Messages to Trace checkboxes
See also
Use the Messages to Trace check boxes on the Message Trace Options dialog box to choose the types 
of messages to trace.

You can configure WinSight to trace any of the following:

All messages
Subgroups of messages
Individual messages
A combination of groups and individual messages

All Messages
The All Messages checkbox allows you to select or deselect all ten subgroups of messages.

When All Messages is selected, all messages in the Individual Messages Display Box are highlighted. 
The All Messages checkbox is dimmed when the list box is used to either select or deselect an 
individual message.

Message Subgroups
To select specific types of messages, uncheck All Messages and check individual message groups. 
Checking the All Messages checkbox also turns on these checkboxes. Unchecking the All Messages 
checkbox turns off previously selected subgroup checkboxes.

When a subgroup is selected, the messages in that subgroup are highlighted in the Individual Messages 
Display Box. The subgroup checkbox is dimmed when the list box is used to either select or deselect an 
individual message in that group. 

"Other" checkbox
The "Other" checkbox allows tracing of all messages that WinSight does not know about, such as 
unknown WM_USER+xxxx and registered messages. This checkbox must be on for these messages to 
be traced. Checking the All Messages checkbox also turns on this checkbox.

Individual Messages list box
The Individual Messages List Box displays all of the messages that WinSight knows about. It is here that 
individual messages are selected or deselected. The All Messages checkbox and corresponding 
subgroup checkboxes are dimmed to indicate when individual messages are selected or deselected.



Messages WinSight tracks
See also
The messages that WinSight tracks are listed under the following group headings.

Click a group to see the corresponding list of messages tracked by WinSight.

Mouse 

Window

Input 

System 

Pen

Initialization

Clipboard 

DDE 

Non Client

Control

MultiMedia

Common controls (WS32.EXE only)

Other



Interpret Value, Hex Value, and Show Times checkboxes
See also
The Interpret and Hex Values check boxes determine the format of the Message Trace view display.

Check the Interpret Values checkbox to interpret message parameters and return values in a readable 
format.

Check the Hex Values checkbox to display message parameters as Hex Values of wParam and lParam, 
and also return Values as Hex.

Check the Show Times (WS32.EXE only) to display a timestmap with each message.



Log File checkbox
See also
Check Log File to log trace messages to a file.

Enter a file name in the input box below the check box. If the file already exists, messages are 
appended to the end of the file.

To stop logging messages to the file, turn off the Log File check box.



Mouse messages
See also
Check Mouse on the Message Trace Options dialog box to trace mouse messages. 

The mouse messages that WinSight traces are:

WM_HSCROLL

WM_LBUTTONDBLCLK

WM_LBUTTONDOWN

WM_LBUTTONUP

WM_MBUTTONDBLCLK

WM_MBUTTONDOWN

WM_MBUTTONUP

WM_MOUSEACTIVATE

WM_MOUSEMOVE

WM_RBUTTONDBLCLK

WM_RBUTTONDOWN

WM_RBUTTONUP

WM_SETCURSOR

WM_VSCROLL



Window messages
See also
Check Window on the Message Trace Options dialog box to trace window messages.

The window messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):

WM_ACTIVATE

WM_ACTIVATEAPP

WM_CANCELMODE

WM_CHILDACTIVATE

WM_CLOSE

WM_CREATE

WM_CTLCOLOR

WM_DESTROY

WM_ENABLE

WM_ENDSESSION

WM_ERASEBKGND

WM_GETDLGCODE

WM_GETMINMAXINFO

WM_GETTEXT

WM_GETTEXTLENGTH

WM_ICONERASEBKGND

WM_KILLFOCUS

WM_MOVE

WM_PAINT

wm_painticon

WM_QUERYDRAGICON

WM_QUERYENDSESSION

WM_QUERYNEWPALETTE

WM_QUERYOPEN

WM_QUIT

WM_SETFOCUS

WM_SETFONT

WM_SETREDRAW

WM_SETTEXT

WM_SHOWWINDOW

WM_SIZE

WM_WINDOWPOSCHANGED

WM_WINDOWPOSCHANGING



Input messages
See also
Check Input on the Message Trace Options dialog box to trace input messages. 

The input messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):

WM_CHAR

WM_CHARTOITEM

WM_COMMAND

WM_DEADCHAR

WM_KEYDOWN

WM_KEYUP

WM_KEYLAST

WM_MENUSELECT

WM_MENUCHAR

WM_PARENTNOTIFY

WM_SYSCHAR

WM_SYSKEYDOWN

WM_SYSKEYUP

WM_SYSDEADCHAR

WM_TIMER

WM_VKEYTOITEM

sm_yomichar

Notification Control Messages
BN_CLICKED

BN_DOUBLECLICKED

BN_CLOSEUP

BN_DBLCLK

BN_DROPDOWN

BN_EDITCHANGE

CBN_CLOSEUP

CBN_DBLCLK

CBN_DROPDOWN

CBN_EDITCHANGE

CBN_EDITUPDATE

CBN_ERRSPACE

CBN_KILLFOCUS

CBN_SELCHANGE

CBN_SELENDCANCEL

CBN_SELENDOK

CBN_SETFOCUS

EN_CHANGE

EN_ERRSPACE

EN_HSCROLL

EN_KILLFOCUS

EN_MAXTEXT



EN_SETFOCUS

EN_UPDATE

EN_VSCROLL

LBN_DBLCLK

LBN_ERRSPACE

LBN_KILLFOCUS

LBN_SELCANCEL

LBN_SELCHANGE

LBN_SETFOCUS



System messages
See also
Check System on the Message Trace Options dialog box to trace system messages.

The system messages that WinSight traces are:

WM_COMPACTING

WM_DEVMODECHANGE

WM_ENTERIDLE

WM_FONTCHANGE

WM_NULL

WM_PALETTECHANGED

WM_PALETTEISCHANGING

WM_POWER

WM_QUEUESYNC

WM_SPOOLERSTATUS

WM_SYSCOLORCHANGE

WM_SYSCOMMAND

WM_TIMECHANGE

WM_WININICHANGE



Pen messages
See also
Check Pen on the Message Trace Options dialog box to trace pen messages.

The pen messages that WinSight traces are:

WM_RCRESULT

WM_HOOKRCRESULT

WM_GLOBALRCCHANGE

WM_SKB

WM_HEDITCTL



Initialization messages
See also
Check Initialization on the Message Trace Options dialog box to trace initialization messages.

The initialization messages that WinSight traces are:

WM_INITDIALOG

WM_INITMENU

WM_INITMENUPOPUP



Clipboard messages
See also
Check Clipboard on the Message Trace Options dialog box to trace initialization messages. 

The clipboard messages that WinSight traces are:

WM_ASKCBFORMATNAME

WM_CHANGECBCHAIN

WM_CLEAR

WM_COPY

WM_CUT

WM_DESTROYCLIPBOARD

WM_DRAWCLIPBOARD

WM_HSCROLLCLIPBOARD

WM_PAINTCLIPBOARD

WM_PASTE

WM_RENDERALLFORMATS

WM_RENDERFORMAT

WM_SIZECLIPBOARD

WM_UNDO

WM_VSCROLLCLIPBOARD



DDE messages
See also
Check DDE on the Message Trace Options dialog box to trace dynamic data exchange messages.

The DDE messages that WinSight traces are:

WM_DDE_ACK

WM_DDE_ADVISE

WM_DDE_DATA

WM_DDE_EXECUTE

WM_DDE_INITIATE

WM_DDE_POKE

WM_DDE_REQUEST

WM_DDE_TERMINATE

WM_DDE_UNADVISE



Non Client messages
See also
Check Non Client on the Message Trace Options dialog box to trace non-client messages.

The non-client messages that WinSight traces are:

WM_NCACTIVE

WM_NCCALCSIZE

WM_NCCREATE

WM_NCDESTROY

WM_NCHITTEST

WM_NCLBUTTONDBLCLK

WM_NCLBUTTONDOWN

WM_NCLBUTTONUP

WM_NCMBUTTONDBLCLK

WM_NCMBUTTONDOWN

WM_NCMBUTTONUP

WM_NCMOUSEMOVE

WM_NCPAINT

WM_NCRBUTTONDBLCLK

WM_NCRBUTTONDOWN

WM_NCRBUTTONUP



Controls messages
See also
Check Controls on the Message Trace Options dialog box to trace control messages.

The control messages that WinSight traces are:

BM_GETCHECK

BM_GETSTATE

BM_SETCHECK

BM_SETSTATE

BM_SETSTYLE

CB_ADDSTRING

CB_DELETESTRING

CB_DIR

CB_FINDSTRING

CB_FINDSTRINGEXACT

CB_GETCOUNT

CB_GETCURSEL

CB_GETDROPPEDCONTROLRECT

CB_GETDROPPEDSTATE

CB_GETEDITSEL

CB_GETEXTENDEDUI

CB_GETITEMDATA

CB_GETITEMHEIGHT

CB_GETLBTEXT

CB_GETLBTEXTLEN

CB_INSERTSTRING

CB_LIMITTEXT

CB_RESETCONTENT

CB_SELECTSTRING

CB_SETCURSEL

CB_SETEDITSEL

CB_SETEXTENDEDUI

CB_SETITEMDATA

CB_SETITEMHEIGHT

CB_SHOWDROPDOWN

DM_GETDEFID

DM_SETDEFID

EM_CANUNDO

EM_EMPTYUNDOBUFFER

EM_FMTLINES

EM_GETFIRSTVISIBLELINE

EM_GETHANDLE

EM_GETLINE

EM_GETLINECOUNT

EM_GETMODIFY

EM_GETPASSWORDCHAR



EM_GETRECT

EM_GETSEL

EM_GETWORDBREAKPROC

EM_LIMITTEXT

EM_LINEFROMCHAR

EM_LINEINDEX

EM_LINELENGTH

EM_LINESCROLL

EM_REPLACESEL

EM_SETHANDLE

EM_SETMODIFY

EM_SETPASSWORDCHAR

EM_SETREADONLY

EM_SETRECT

EM_SETSEL

EM_SETRECTNP

EM_SETTABSTOPS

EM_SETWORDBREAK

EM_SETWORDBREAKPROC

EM_UNDO

LB_ADDSTRING

LB_DELETESTRING

LB_DIR

LB_FINDSTRING

LB_FINDSTRINGEXACT

LB_GETCARETINDEX

LB_GETCOUNT

LB_GETCURSEL

LB_GETHORIZONTALEXTENT

LB_GETITEMDATA

LB_GETITEMHEIGHT

LB_GETITEMRECT

LB_GETSEL

LB_GETSELCOUNT

LB_GETSELITEMS

LB_GETTEXT

LB_GETTEXTLEN

LB_GETTOPINDEX

LB_INSERTSTRING

LB_RESETCONTENT

LB_SELECTSTRING

LB_SELITEMRANGE

LB_SETCARETINDEX

LB_SETCOLUMNWIDTH

LB_SETCURSEL



LB_SETHORIZONTALEXTENT

LB_SETITEMDATA

LB_SETITEMHEIGHT

LB_SETSEL

LB_SETTABSTOPS

LB_SETTOPINDEX

STM_GETICON

STM_SETICON



Multimedia messages
See also
Check Multimedia on the Message Trace Options dialog box to trace multimedia messages.

The multimedia messages that WinSight traces are:

MM_JOY1MOVE

MM_JOY1BUTTONDOWN

MM_JOY1BUTTONUP

MM_JOY1ZMOVE

MM_JOY2MOVE

MM_JOY2BUTTONDOWN

MM_JOY2BUTTONUP

MM_JOY2ZMOVE

MM_MCINOTIFY

MM_MIM_CLOSE

MM_MIM_DATA

MM_MIM_ERROR

MM_MIM_LONGDATA

MM_MIM_LONGERROR

MM_MIM_OPEN

MM_MOM_CLOSE

MM_MOM_DONE

MM_MOM_OPEN

MM_WIM_CLOSE

MM_WIM_DATA

MM_WIM_OPEN

MM_WOM_CLOSE

MM_WOM_DONE

MM_WOM_OPEN



Common controls messages
See also
Check Common Controls (WS32.EXE only) to trace the following types of messages:

All ACM_ messages

All HDM_ messages

All HKM_ messages

All LVM_ messages

All PBM_ messages

All SB_ messages

All TB_ messages

All TBM_ messages

All TCM_  messages

Att TTM_ messages

All TVM_ messages

All UDM_  messages



Other Messages
See also
Check Other on the Message Trace Options dialog box to trace other types of messages.

The other messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):

wm_alttabactive

wm_begindrag

WM_COMMNOTIFY

WM_COMPAREITEM

wm_convertrequest

wm_convertresult

WM_DELETEITEM

wm_dragloop

wm_dragmove

wm_dragselect

WM_DRAWITEM

WM_DROPFILES

wm_dropobject

wm_entermenuloop

wm_entersizemove

wm_exitmenuloop

wm_exitsizemove

wm_filesyschange

WM_GETFONT

wm_gethotkey

wm_isactiveicon

wm_lbtrackpoint

WM_MDIACTIVATE

WM_MDICASCADE

WM_MDICREATE

WM_MDIDESTROY

WM_MDIGETACTIVE

WM_MDIICONARRANGE

WM_MDIMAXIMIZE

WM_MDINEXT

WM_MDIRESTORE

WM_MDISETMENU

WM_MDITILE

WM_MEASUREITEM

WM_NEXTDLGCTL

wm_nextmenu

wm_querydropobject

wm_queryparkicon

wm_setvisible

wm_sethotkey



wm_sizewait

wm_syncpaint

wm_synctask

WM_SYSTEMERROR

wm_systimer

wm_testing





Stop! and Start! Menu
See also
Use the Stop! and Start! menu to turn off or on real-time updating in WinSight. 

All views are kept current as classes are registered, windows are created and destroyed, and messages 
are received. 

This command is a toggle. When you choose Stop! to suspend activity, the command changes to Start!. 
When you choose Start! to resume activity, the command changes to Stop!.

Using Stop! allows you to study a particular situation. It also removes the overhead of having WinSight 
update itself constantly.

You can also use Messages|Trace Off to stop message tracing.





Help menu
The Help menu provides access to online Help, which comes up in a special Help window. One-line 
menu hints also appear on the status line at the bottom of the screen whenever you select a menu 
command.

The Help menu commands are:

Index

Finding Windows

Tracing Messages

Menu Commands

Keyboard

Mouse

Using Help

About WinSight



Help | Index (F1)

The WinSight online Help has a contents screen that summarizes the organization and contents of the 
Help system. 

To access the Help system from the index, choose one of the highlighted words or pictures on the 
contents: click it or Tab to it and then press Enter.

For more information on how to use a Help system under Windows, choose the Help|Using Help menu 
command.



Help | Finding Windows

The Help|Finding Windows command displays help on locating windows.



Help | Tracing Messages

The Help|Tracing Messages command displays help on tracing messages.



Help | Menu Commands

Help|Menu Commands displays help on WinSight menus.



Help | Keyboard

The Help|Keyboard command displays help on the keyboard.



Help | Mouse

The Help|Mouse command displays help on the mouse.



Help | Using Help

The Help|Using Help command displays information on how to use the WinSight Help system (or any 
other Help system under Windows).



Help | About

The About command displays a dialog box that shows copyright and version information.

Click OK or Enter to close the About dialog box.




